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Air Manager (On-Air Management Client)

Air Manager is a multi-functional client application for management of server recording and playout
channels, SL NEO graphic stations and media data storages. The app is used to compose, edit and
execute recording and playout schedules both for separate servers and for automated recording,
archiving, on-air and production complexes.

Air Manager is the main instrument for on-air and recording operators when forming programs in
broadcasting complexes.

Air Manager Settings

Configuring Air Manager allows setting its connections to active server modules of one or several SL
NEO media servers that operate in a general network. Besides, it allows configuring different
application functions and customizing user interface parameters (fonts, styles, etc).

Setting must be implemented every time when installing Air Manager to a new client station,
changing IP addresses of SL NEO servers or adding new services (databases, record and playout
channels).

The configuring procedure is launched in menu Air Manager→File→Configure….

Preview Tab

Preview tab allows configuring basic display modes and contains two windows: Preview Parameters
and Output Hardware.

https://wiki.skylark.tv/_detail/manual/mam_airmgr.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_configure_preview_v2.png?id=manual%3Aairmanager
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Parameter Description
Preview Parameters Section

Display engine

Choosing a video display technology in the File Monitor window. The choice
depends on work features of a client PC video card with Air Manager launched.
Sometimes, motherboard integrated video cards don’t display video in the Default
mode. If this occurs, choose a mode from the list and reload the app. Supported
modes:
•
Basic GDI
•
Hw Scale
•
Hw Overlay
•
Basic GDI HQ
•
OpenGL
•
Default

Deinterlace Turning on/off the mode of forced deinterlacing while viewing full resolution video
in the File Monitor window.

Use Lowres
Proxy

Turning on/off the mode of displaying proxy-copies (if there are any) in the File
Monitor window. If the option is inactive, the File Monitor window displays video in
full resolution. The app must be reloaded after activating the option.

Compress Audio

Activating this option allows the app to accept a compressed low-speed audio
stream while viewing materials in the File Monitor window. The function is useful in
case of a non-compressed proxy-copy audio track (PCM with 1538 kBit/s speed for
a stereo pair) and relatively low throughput of the communications channel
between SL NEO server and client station. When the Compress Audio option is
activated, the server database module automatically starts creating a compressed
audio stream for viewing, even if the proxy-copy original stream is PCM (thus,
reducing the channel load). Encoding parameters cannot be configured.

Sound Channels

The number of audio channels displayed in the File Monitor window and in the app
rec-lists. For this option to work properly, the corresponding number of audio
channels must be configured at the server platform. The option allows listening up
to eight audio channels at the client station while viewing materials in the File
Monitor window.

Show audio
overload

The option allows File Monitor window to display relative values of audio levels
greater than zero. The app must be reloaded after activating the option.

Reference Audio
Level

The parameter default value is “0”. The level set in this field defines offset of levels
displayed by sound indicators in File Monitor and Record windows to a set number
of decibels relative to the dBFS scale. This option is necessary when using a scale
of audio levels with a protective range in a digital sound signal. For instance, the
maximal level of the audio track is -12 dB by the dBFS digital scale. Indicators
displaying -12dB maximal level would make operators work very inconvenient. To
make File Monitor indicators and the Record window display the value 0 dB
corresponding the dBFS level of -12 dB, a +12 dB shift is set in the Audio Level
field.

Sound meter
integration
period

Sound meter integration period in milliseconds

Show ANCs Displays ANC data (if any) for a current frame in the File Monitor window.
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Parameter Description
Preview Parameters Section

Output
Hardware

This section allows redirecting audio/video display from the File Monitor
window to an output board installed at a client station. Thus, you can
view materials using a separate monitor.

IO Board

Choosing the type of a hardware output platform (board) installed at a client
station (or at the server itself). Supported:
•
Плата Matrox DSX,
•
Плата DekTec DTA (SDI only),
•
Плата BlackMagic Decklink,
•
Computer Screen - client station video card

HW Channel
The number of a physical playout channel (port) of the output board, which will be
used for displaying by Air Manager. Any conflicts while setting this parameter
should be avoided (no other software, including SL NEO server software, should use
the port set for Air Manager).

Video Mode Choosing display format
Conversion Setting the mode of Up/Down conversion

Use AFD

Keyer Mode The mode when a board may form a pair of Fill+Key signals while viewing 32-bit
video with alpha-channel (External mode developed for Matrox DSX boards).

Audio Meter Activates the audio level indicator while viewing through the output board.
Display
Timecode

Activates a counter displaying the cursor current position in the File Monitor
window (timecode format) when viewing via output board.

Remap audio
channels

Activates support of sound streams redirection in case of output through a board.
Control is implemented by switches under sound indicators in the File Monitor
window.

After configuring the modes in the Output Hardware window,
Air Manager should be reloaded.

Look and feel Tab

Look and Feel tab allows configuring appearance of the Air Manager user interface.



Last update: 2023/05/08 15:59 manual:airmanager https://wiki.skylark.tv/manual/airmanager

https://wiki.skylark.tv/ Printed on 2025/01/16 20:48

Parameter Description

Tables look The window settings allow changing the font type and size in rec- and playlists (Broadcast
and Record windows).

Font family Setting the font name for the Media Browser window and for all Broadcast and Record windows.
Font size Setting the font size for all windows.
Cell height Setting the line height in Broadcast, Record, and Media Browser windows.
Draw
horizontal
lines

Activates displaying horizontal lines separating columns and rows in rec-lists and playlists

Draw vertical
lines Activates displaying veretical lines separating columns and rows in rec-lists and playlists.

Highlight
even/odd lines Activates highlighting for adjacent lines in rec- and playlists.

Panel font size Setting font size for the information panel at the bottom part of the Broadcast window.

Lists
autoscrolling

Window settings allow configuring parameters for rec-lists and playlists automatic
scrolling (Auto Scroll). The function of scrolling is activated automatically with the
sequence (rec-list, playlist) launch, and allows the operator to see the executable line and
the previous/following lines. Auto Scroll is disabled automatically when editing a text line
directly during its execution. The function requires manual re-activation in Air Manager
Top-menu after the end of editing.

AutoScroll
button text This field contains the text to be displayed next to the Auto Scroll checkbox in Air Manager Top-menu.

Decorate root Enables additional elements when displaying group lines in Broadcast windows.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_lookandfeel_v2.png?id=manual%3Aairmanager
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Parameter Description

Tables look The window settings allow changing the font type and size in rec- and playlists (Broadcast
and Record windows).

Number of
rows above
current

Setting the number of lines displayed before the executable line in Broadcast and Record windows.

Default D&D
mode

Setting the mode to use when mouse dragging a line in Broadcast and Record windows. The default
value is copying lines (Copy).

Clipboard and shortcuts
Default Image
duration

Excel style
clipboard

Enabling this option will add a thick dashed frame to copied lines in rec-lists and playlists. It is
necessary to clearly state the place of inserting copied lines in this mode. Copied lines will overwrite
the current ones in the place of insertion. (To activate this option, Air Manager must be reloaded)

Auto clear
replace mode

Automatically disables the Replace function in playlists. Replace - replacing the selected playlist line
with a new one. The Replace mode is activated once while setting the Replace parameter at the
Broadcast window bottom part and is disabled automatically afterward. Deselection of the Auto clear
replace mode check box in settings turns off automatic deactivation of the Replace function.

Buttons look Window settings allow changing the font type and size for Air Manager Top-menu buttons:
Font family Setting the font type for buttons.
Font size Setting the font size.
Button height Setting the buttons height.
Other
Show frames
in clock

Activation of this parameter allows displaying hundredth parts of seconds in the clock placed in Air
Manager Top-menu.

Frame
validation
time

Activation of this parameter allows displaying hundredth parts of seconds in the clock placed in Air
Manager Top-menu.
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Parameter Description

Tables look The window settings allow changing the font type and size in rec- and playlists (Broadcast
and Record windows).

Use Dark
Theme
(restart req)

Changes the Air Manager color scheme for work in dark or semi-dark rooms. Reload the app to apply
changes. Added in 2.2.28 version. Interface with enabled option::

Interface with disabled option:

https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_28
https://wiki.skylark.tv/_detail/manual/airmgr_configure_lookandfeel_dark_theme.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_configure_lookandfeel_norm_theme.png?id=manual%3Aairmanager
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Parameter Description

Tables look The window settings allow changing the font type and size in rec- and playlists (Broadcast
and Record windows).

Use Docking
windows
interface
(restart req)

Activation of the “window-snapping” interface. Reload the app to apply changes. Added in 2.2.28
version. Interface with enabled option:

Set Group
Title to Group
Name

The Title column of the group heading displays the group name. By default, it displays Title of the first
group element. (To activate this option, Air Manager must be restarted)

Highlight
Grouped
Items

The Title fields for lines united into a group will have a grey frame (To activate this option, Air
Manager must be restarted)

Record list Tab

The tab allows configuring column displaying for rec-lists and contains fields for:

forming a set of attributes (columns) displayed in rec-list windows, with an option to set a user-
defined name for every column,
user-defined names for Air Manager Top-menu buttons,
user-defined names for displayed current statuses of rec-list lines.

https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_28
https://wiki.skylark.tv/_detail/manual/airmgr_configure_lookandfeel_docking.png?id=manual%3Aairmanager
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Parameter Description
Column List of columns of a rec-list, with an option to turn on/off their displaying
Text Override recording list columns captions
Button List of buttons of the Air Manager top panel
Text Specifying user-defined captions for buttons of the Air Manager top panel
Job Status The list of record-list statuses
Text Override job status title

Broadcast list

The tab allows configuring column displaying for playlists and contains fields for:

forming a set of attributes (columns) displayed in playlist windows, with an option to set a user-
defined name for every column,
user-defined names for Air Manager Top-menu buttons,
user-defined names for Air Manager Top-menu buttons.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_recordlist.png?id=manual%3Aairmanager


2025/01/16 20:48 9/56 Air Manager (On-Air Management Client)

wiki.skylark.tv - https://wiki.skylark.tv/

Parameter Description
Column List of columns of a playlist, with an option to turn on/off their displaying
Text Override playlist column titles
Button List of buttons of the Air Manager top panel
Text Specifying user-defined captions for buttons of the Air Manager top panel
Job Status The list of playlist-list statuses
Text Override playlist statuses text

Color

ЗSetting status color in the Status column Click on the field to activate a dialog for color settings

https://wiki.skylark.tv/_detail/manual/airmgr_configure_broadcastlist_v2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_configure_broadcastlist_2.png?id=manual%3Aairmanager
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Parameter Description

User Status
Config

The function defines four user statuses of playlist lines that are displayed according to the user-
defined criteria.

The window of choosing a status for editing.

The window of setting criteria for status displaying (similar to setting the criteria for actions
triggering).

Example of displaying the user status in a playlist. Added in 2.3.3 version.

Storage

The Storage tab allows to configure local or network connections with database services of one or
several SL NEO servers that work in a general network.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_userstatus_1.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_configure_userstatus_2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_configure_userstatus_3.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.3#s_2_3_3
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Parameter Description

Storage
servers

The window containing IP addresses of SL NEO servers with databases
connected to Air Manager. These settings are necessary for providing Air
Manager access to SL NEO Media Database modules and displaying clips
in Media Browser and File Monitor windows.

Add/Edit

The button allows adding/editing the server with a database you want to connect.

•
Name - a random media database name (e.g., MEDIA1, SRV1, SRV2),
•
Type - Storage type:
    ⚬
SL Media Storage - Skylark server media database (recommended)
    ⚬
File Folder - File folder
    ⚬
P2 Card
    ⚬
Avid MXF/OP-Atom
    ⚬
Avid Unity/Interplay
•
Address - IP address of the server containing the SL Media Storage service,
•
Service - the sequence number of SL Media Storage ((the number may be found in
the server control web console: Administrator Control
Panel→Manage→Storages.
•
User/Password - Username and password to access the media database. It is
used to set access rights for the media database, according to the list of users
registered at the server.
If parameters of server IP settings are correct, the left part of Media Browser will
display a root folder with the name of the connected database. It will also display
the database service “online” status. Corresponding SL NEO Media Storage
modules must be activated at the servers.

Delete Deletes the selected connection.
Move Up/Move
Down

The buttons serve for sorting the list. The order set here is used for displaying
servers and their databases in the Media Browser window.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_storage_1.png?id=manual%3Aairmanager
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Parameter Description

Storage
servers

The window containing IP addresses of SL NEO servers with databases
connected to Air Manager. These settings are necessary for providing Air
Manager access to SL NEO Media Database modules and displaying clips
in Media Browser and File Monitor windows.

Del to trash for

The parameter allows setting time (in days) of automatic deletion of materials from
the recycle bin. The technology of removing files into a recycle bin works in the
following way: when deleting a clip from the Media Browser window, Air Manager
puts the material into the Trash folder and defines the time of automatic deletion
for this material according to the value specified in Del to Trash field. Setting this
parameter is necessary for every workplace (for every Air Manager application
respectively).

Del to trash
override

Allows redefining time settings for storage of a deleted clip in the recycle bin,
changing the value set in media database settings of the server part of software.

Low space alarm Low space alarm threshold

Metadata
Schema…

Log user actions
to

Specifying a folder to store a record of a log-file that contains user actions
information.

Icon view The window contains fields that allow setting the “Icon view” mode of
icon and text displaying in the Media Browser window.

Icon size Icon size
Icon view
spacing Spacing between icons

Icon
arrangement Icon arrangement order Left to right: row layout. Top to bottom: column layout

Icon text Icon text arrangement
Text word wrap Word wrapping in long texts
Thumbnail
view

The window contains fields that allow setting the “Thumbnail view” mode
of icon and text displaying in the Media Browser window

Icon size Icon size

Column Column name specified in Air Manager. You can uncheck displaying certain
columns.

Name The displayed column name. Allows to change Media Browser column titles and set
user-defined ones.

List view The window contains fields that allow setting the “List view” mode of icon
and text displaying in the Media Browser window.

Icon size Icon size

Column Column name specified in Air Manager. You can uncheck displaying certain
columns.

Name The displayed column name. Allows to change Media Browser column titles and set
user-defined ones.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_storage_2.png?id=manual%3Aairmanager
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Parameter Description

Storage
servers

The window containing IP addresses of SL NEO servers with databases
connected to Air Manager. These settings are necessary for providing Air
Manager access to SL NEO Media Database modules and displaying clips
in Media Browser and File Monitor windows.

Configure XMP
Columns…

Specifying metadata schema fields displayed in Media Browser.

Choose a field name from the drop-down list and press the button “Add”. Press
“Ok”. Activate the selected items in Thumbnail view and List view areas.

Values in selected fields will be displayed in corresponding columns, in the right
section of Media Browser window.

Actions

The tab Actions allows setting modes of start of events for rec- and playlists.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_storage_3.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/mam_maconnect_config_xmp_col2.png?id=manual%3Aairmanager
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Parameter Description
Play/Rec start
hot key

Setting a “hot key” at a client station to manage start of events of rec-lists and
playlists.

Controller type Choosing a controller model for work with recording channels (VTR control, viewing
materials in Media Browser).

Port The sequence number of controller connected to a client station

Broadcast list
actions

The window of setting Top-Menu buttons for playout management. These
settings might be useful while using SL NEO server as a file player in
broadcasting studios and in situations, when the playout management
process requires complete involvement of an operator.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_actions_v2.png?id=manual%3Aairmanager
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Parameter Description

Jump

Setting variant responses for the Jump (GoTo) button — commands of an urgent
transition to executing any selected action in playlist:
•
Make current only - pressing the GoTo button continues execution of the current
event, the selected playlist line status changes to GoTo. Further pressing the Play
button starts playback of the selected line. This option allows replacing the line
designated for transition on GoTo command.
•
Make current and Pretake - pressing GoTo continues executing the current
event and changes the selected playlist line status to Cued (event is ready for a
start command). Further clicking the Play button will lead to instantaneous start of
playout of the selected line. This option doesn’t allow choosing another line — the
transition is possible only to a line with Cued status.
•
Make current and Play (default value) — pressing GoTo instantaneously starts
execution of the selected playlist line.
•
Restart and Pretake - pressing GoTo stops execution of the current event and
changes the selected playlist line status to Cued (the event is ready for the start
command).

Skip
Setting variant responses for the Skip button – the command of urgent transition to
execution of the next playlist event. The Skip command is a particular case of GoTo
command, so variants of response are identical.

Start type hotkey Column+Value
Enable manual
start for
“HardTime” jobs

This parameter is default and allows manual launch of playback for events that
have the Hard Start type of start.

Use sync bar
only

The option allows managing playback channels using only the buttons for
synchronous channel management in Air Manager Top-Menu (see Synchronous
operations). Activation of Broadcast windows will not have any influence on the
choice and change of the managed channel.

Message alert
sound

Specifying a WAV audio file to play back when receiving messages in the Message
List window.

Message alert
delay

Auto strip
storage

When active, this option allows using a clip MediaID while dragging it into a playlist,
not linking it to a certain media database. The program channel will search the clip
in all connected media databases and play back from the first available one
containing the clip. If the option is inactive, Air Manager will use a full path to the
clip when dragging it into a playlist, including the media database address.
(medb://localhost:9900/title:myclipMediaID)

Check Part Media
The parameter allows activating signalization in Broadcast windows and playlist
editors for the lines containing materials in the process of import or recording (line
text color is red, the Status playlist column displays a title Part Media). The app
uses Media fields for verification.

Check media in
editors

The parameter turns on/off verification and signalization in playlist editors for lines
with materials absent in the server database (the line text color is red, the Status
column of a playlist editor says No Media). The app uses Media fields for
verification.

Check Media
Offline
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Parameter Description

Default Start
Type

Setting the default start type while forming playlists. There are the following start
types:
•
Auto или Sequence - default type of start for manual placement of clips to the
playlist. Lines with this type start automatically after playback of the previous line,
providing non-stop execution for a sequence of events.
•
Manual - manual launch of lines with Play, GoTo or Next commands. Using this
start type by default when forming playlists might be useful during playback of
clips in broadcasting studios, production of real-time programs, and when there is a
need to play back materials randomly instead of a sequence.
•
Hard Start - тstart of execution of a line/event at a set time. Start of execution is
implemented by the server system timer (client PC time may differ). Use NTP time
syncronization.

Media
Certificates…
Strict Media
Markers
Allow Jump No
Media Transition to NoMedia lines with the GoTo button

DnD Player
attribute for
main lists

When dragging the selected clip from the Media Browser window to the main
playlist window, transfers the Player column value

Editor autosave
period Periodicity of autosave for the playlists editor, in minutes.

Confirmation on
Reset Activates confirmation when pressing the Reset button in the playlist

Confirmation on
Stop Seq Activates confirmation when pressing the Stop button in the playlist.

Browser DblClk
inserts

When the option is active, a double-click on a clip in Media Browser will add it to a
selected playlist position.

Player colors

Play button
sends next

The setting changes the “Play” button functionality in a way it stays active during
the element playback and launches the next element, when pressed. Added in
2.3.37 version

Fix durations on
playlist load

The setting changes the “Play” button functionality in a way it stays active during
the element playback and launches the next element, when pressed. Added in
2.3.63 version

Check secondary
media

Turning off the media status check for secondary events. When checked, the status
check is on. Added in 2.3.74 version.

Rec list actions Settings of Top-Menu buttons for record management

https://wiki.skylark.tv/manual/time_sync
https://wiki.skylark.tv/changelog/slneo_2.3#s_2_3_37
https://wiki.skylark.tv/changelog/slneo_2.3#s_2_3_63
https://wiki.skylark.tv/changelog/slneo_2.3#s_2_3_74
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Parameter Description

Jump

Setting variant responses for the Jump (GoTo) button — the command of urgent
transition to executing any selected action in a rec-list
•
Make current only - pressing the GoTo button stops recording the current event,
further clicking the Rec button launches recording of a selected line
•
Make current and Pretake - pressing the button GoTo stops recording the
current event, the selected rec-list line status changes to Cued (event is ready for
the start command). Further pressing the Rec button instantaneously starts
recording the selected line.
•
Make current and Record (default value) - pressing the GoTo button
immediately starts recording the selected rec-list line.

Enable manual
start for
“HardTime” jobs

This parameter is default and allows manual launch of recording for events with the
Hard Start type of start.

Check media on
all storages

The option allows checking coincidence of names in the Media fields for record
events and clip names on all network databases connected to Air Manager.

Use sync bar
only

The option allows managing recording channels using only buttons for synchronous
channel management in Air Manager Top-Menu (see Synchronous operations).

Services

The option allows managing recording channels using only buttons for synchronous channel
management in Air Manager Top-Menu (see Synchronous operations).
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Parameter Description
Record
servers

Configuring parameters of Air Manager connections to corresponding SL
NEO File Recorder modules.

Name Specify a displayed service name (e.g. REC1, REC2).

Host Specify IP address of the server with a corresponding SL NEO File Recorder service
launched.

Num Specify the recording service sequence number.
New Server Specify the recording service sequence number.
Delete Server Deleting the selected connection.
Broadcast
servers

Window for configuring parameters of client application connections to the
corresponding SL NEO Program Player playback modules.

Name Specify a displayed service name (e.g. CAST1, CAST2).
Host Specify IP address of the server with SL NEO Program Player service launched.
Num Specify the service sequence number.

https://wiki.skylark.tv/_detail/manual/airmgr_configure_services.png?id=manual%3Aairmanager
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Parameter Description
Record
servers

Configuring parameters of Air Manager connections to corresponding SL
NEO File Recorder modules.

Passwd

Codeword for playlist management.
SL NEO Program Player server module allows simultaneous work with a playlist from
several client workplaces. In certain cases (e.g., a server connected to a corporate
network) it might be undesirable for all computers to have the option of playlist
management.
To avoid unauthorized change of on-air playlists, Air Manager settings include
codeword settings. In case of incorrect codeword entry, playlist will be available for a
client workplace in the viewing mode only. All list playback and editing management
functions will be blocked. Codeword is set in Program Channel settings:
Administrator Control Panel→Manage→Program
Outputs→Program_N→Automation→Control Code.

GrHost Specifying IP address of a graphic station (in case of working with an external
graphic station)

GrNum Specifying program channel address of a graphic station (in case of working with an
external graphic station)

GrPl Specifying program channel address of a graphic station (in case of working with an
external graphic station)

Storages
Specifying media databases used by the playlist to check clip availability (displaying
NoMedia status in case of absence). You can find media database names in the
Name column of the Storage tab. Media database names are case-sensitive and
must be comma-separated (,).

New Server Creating a new connection.
Delete Server Deleting the selected connection

VTR servers Configuring parameters of client application connections to the VTR
management service.

Host Specify IP address of the PC with launched device management service and
configured VTR management

Num Define the service number.
Description Specify a random name for VTR (VTR1, VTR2, but not VTR).
New Creating a new connection.
Delete Deleting the selected connection.

Settings Lock

Air Manager has options –lock-config and –unlock-config to show/hide the “Configure” item in the File
menu Air Manager→File→Configure…. This option allows the administrator to exclude access of
users to application settings.

Option Activation

To deactivate the Configure menu, launch Air Manager from the command line with a lock parameter:

airmgr --lock-config

https://wiki.skylark.tv/manual/program_channel_configuration
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Option Deactivation

To activate the Configure menu, launch Air Manager from the command line with an unlock
parameter:

airmgr --unlock-config

Saving/Restoring Air Manager Settings

Saving Configuration

Параметр Description
Ok Applying changes
Cancel Cancel applied changes
Save to file Saving app settings to a configuration file *.amc (Air Manager Configuration)
Load from file Loading settings from a configuration file *.amc

Saving Window Arrangement

To save window arrangement to an *.awp file (Air Manager Windows Position), you can use the menu
command Air Manger→Window→Save Windows. To restore window arrangement, use the menu
command Air Manger→Window→Load Windows.

Saving Full Configuration

To save the full current configuration of Air Manager, use the Windows registry editor and export a file
with the following branch:

[HKEY_CURRENT_USER\Software\Skylark\AirManager]

To quickly transfer Air Manager configuration to another PC or to restore the previous configuration,
just launch the corresponding *.reg file to enter data to Windows registry.

Before the 2.0.10 version saving Air Manager configurations was implemented to

[HKEY_LOCAL_MACHINE\SOFTWARE\SkyLark\AirManager]

Toolbar
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You can manage displaying toolbar elements via menu available on a right-click in the delimiter area.
Elements marked with a flag are displayed in the toolbar area.

Element Appearance Description

Cue

Manual preparation of playlist lines to the start of execution. The system opens the
corresponding media-file for reading, prepares it for playback (loads it to the
memory and I/O board), and awaits the Play start command. At the end of Cue
procedure the initial frame of prepared clip appears at the video output of
corresponding server channel in a split second, in the freeze frame mode. Clip
playback in the prepared line begins immediately after activating the Play
command.
Pressing Cue launches preparation of lines of the following types:
•
The first playlist line with Wait status,
•
The playlist line with Wait status positioned after already executed lines (Done
status) or lines, whose execution is ignored by user (Skipped status).
In the line sequence execution mode, the command for preparing the next line is
launched automatically in the background mode to facilitate clean switch to the
next clip (line).

Start Play

Launches execution of a line sequence in the active Broadcast window. Pressing
Play without preliminary pressing Cue will automatically execute the Cue
command and clip playback will start in a split second. If every line has the
Sequence type of start, executing the rest of lines will happen automatically, with
no operator participation.

Start Rec
Launches execution of line sequence in the active Record window. Pressing Rec
without preliminary pressing Cue will automatically execute the Cue command and
start clip recording. If every line has the Sequence type of start, executing the rest
of lines will happen automatically.

GoTo

Emergency stop of executing the current event and switch to any other selected
playlist line. Thus, after selecting the needed line, it is possible to jump up/down
the list to several lines and launch immediate prompt execution of the needed
event. The mode of command execution depends on settings:
•
For a playlist - File→Configure→Actions→Broadcast list actions→Jump.
•
For rec list - File→Configure→Actions→Rec list actions→Jump.

Freeze
Suspends playback of the executable line in the active Broadcast window. When
activating this mode, the Freeze button is lit light green and the picture on the
corresponding video server output is “frozen”. Pressing Freeze again continues
playback.

https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_menu.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_cue.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_play.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_rec.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_goto.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_freeze.png?id=manual%3Aairmanager
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Element Appearance Description

Marker

Sets a marker on the video. Function is active in the Record window. Function of
manual indexing media materials within the recording process and forming a
collection of key frames.
The function simplifies searching editing points during further material trimming
and marking. Every pressing the Marker button fixes the current time code value
at the moment of recording and forms a key frame in the separate window “Key
Frames”. The set markers are displayed on the Shuttle line and in the File Monitor
window during further clip editing. When selecting the needed marker or key
frame in the Key Frames window, the File Monitor window marker moves to the
corresponding TC position.

Next
The command provides emergency stop of execution of a current event in the
active Broadcast window and switches to execution of the next in order playlist
event (no status).

Stop

The command stops playback of a current line and the entire sequence in the
active Broadcast window. Activating this mode stops execution of the current
event with no transition to the next event. The stopped line gets the Wait status
and is ready for repeated execution. Repeated playback of the stopped event
occurs in case of further pressing Cue and then Play, or just Play. The version
2.0.154 allows setting confirmation for pressing this button when working with
playlists. Configuring the option: AirManager→Меню
File→Configure→Actions→Confirmation on Stop Seq. If the option is on,
pressing the button opens a dialogue window for confirmation:

Reset

The command stops playlist execution in the active Broadcast window, resets
statuses of all lines and assigns them with Wait status. Further pressing the Play
button will start playlist execution from the first line. The function works similarly
for record lists. The version 2.0.154 allows setting confirmation for pressing this
button when working with playlists. Configuring the option: AirManager→Меню
File→Configure→Actions→Confirmation on Reset. If the option is on,
pressing the button opens a dialogue window for confirmation:

Hard Start

Activation/deactivation of the Hard Start mode when trimming events. When the
HS Jumps button is on, the Hard Start mode works as usual, trimming clips to
provide broadcast of the next Hard Start event on time. Deactivation of the HS
Jumps button plays the previous clip to the end and displaces broadcast of the
Hard Start event. Other than that, all Hard Start mode functions remain active
even in case of deactivation of the HS Jumps button.

Hold

Holding the current event. Pressing the Hold button assigns the current event with
the Hold status, infinitely holding it with no switch to the next event. The Hold
function is useful for broadcasting events with set duration values from external
lines in cases that require extending events duration before automatic switch to
the next event (e.g., to extend duration of a news broadcast). Event Dur field will
dynamically display the “extra time” value. Switching to the next event is
implemented by Next or GoTo buttons.

Alarm Clip

The command for emergency switch to the “alarm” clip. Pressing the button
inserts a line containing a clip with emergency sequence into the current playlist
position and switches to this line. The line gets the Hold status, the app infinitely
plays the “alarm” clip with no automatic switching to the next event. The Alarm
Clip mode and alarm clip title must be configured beforehand. Switching to the
next event is implemented by Next or GoTo buttons.

Prev Marker Moves the playback marker to the previous key frame in the playlist window. The
function works for the executed (Play or Freeze) clip with marked key frames.

Next Marker Moves the playback marker to the next key frame in the playlist window. The
function works for the executed (Play or Freeze) clip with marked key frames.

https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_marker.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_next.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_stop.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_154
https://wiki.skylark.tv/_detail/manual/airmgr_confirm_playlist.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_reset.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_154
https://wiki.skylark.tv/_detail/manual/airmgr_confirm_playlist.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_hs1.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_hs2.png?id=manual%3Aairmanager
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Element Appearance Description

Preview

The function is available when managing the external matrix switch by the
“switcher after server” scheme. The button allows to send a command to the
switcher for external signal preview at the Preview output. The server must be pre-
configured to manage a matrix switch. The switch preview port number is
transferred from program channel settings. To implement switching, choose a
LIVE-clip from the playlist and click Preview.

Edit

AutoScroll

Automatic scrolling of playlists. The function is activated automatically when
launching a sequence and allows an operator to see the executable line, previous
and next lines within the executing process. The function is turned off
automatically when editing list lines directly within the executing process and
must be manually re-activated at the end of editing. The number of lines displayed
before and after the executable line is set in the Air Manager Configuration menu.
The function works similarly for record channels.

Synchronous
operations

Buttons for synchronous management of playback channels (Broadcast windows).
The number of buttons corresponds to the number of configured channels in Air
Manager Configuration menu. In case of pressing several buttons CAST_1, CAST_N,
commands for managing selected playback channels will be launched
synchronously. If buttons for synchronous management of playback channels are
inactive, the channel with the active Broadcast window will implement
management.
If one synchronous management button is active, the app will implement
management for the corresponding playback channel. Activating Broadcast
windows does not affect selection and change of the manageable channel.
The function works similarly for record channels.

Lock file
monitor

The function allows the user to lock in clip displaying in the File Monitor window
without switching to viewing other clips during further activation of clips and
playlist lines. After activating this function, the File Monitor window (and Key
Frames window respectively) will display the clip selected in the Media Browser
window or in the playlist line before its activation.

Origin
timecodes

Displaying the original time code in the File Monitor window. The internal time
code beginning from 00:00:00:00 is default while viewing files. The original time
code may be added during clip import or during recording from an external line.

Date/Time
The block for displaying current date and time. Displayed time may differ from
server time, as the time value is taken from the client machine local clock. To fix
the problem, configure time syncronization.

Record/play
delay

Message List
 

Air Manager Message List displays events connected with automatic load of
playlists from watch-folders in “reflection” and “upload once” modes.

List items
above

Allows setting fixed number of lines displayed above the executable line. The rest
of lines will be hidden.

Элементы
Marker
Displays

Adds configurable counters to the toolbar area.

Action1 и
Action2

Generation of Item Action 1 and Item Action 2 for the current (selected) playlist
element. The buttons can be activated by CTRL+1 and CTRL+2 respectively. Item
Action 1 and Item Action 2 are program channel General events. They may be
used, for instance, to send graphics into graphic layers for playout or to the second
program channel for a preview. Added in 2.3.33 version.

https://wiki.skylark.tv/_detail/manual/airmgr_toolbar_preview.png?id=manual%3Aairmanager
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Media Browser Window

Clip Management Menu

Right click context menu of Media Browser opens access to different MAM functions for working with
clips.

Menu item Description
Export… Opens the export dialog for a selected clip
Export Audio… Opens the audio track export dialog for a selected clip
Render… The option is identical to the export dialog for a selected clip

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_v3.png?id=manual%3Aairmanager


Last update: 2023/05/08 15:59 manual:airmanager https://wiki.skylark.tv/manual/airmanager

https://wiki.skylark.tv/ Printed on 2025/01/16 20:48

Menu item Description
Attach Media… Opens a dialogue for connecting video materials to a selected asset.

Create Proxy…
Creates a task for forming LRV profile for a selected clip. This option is useful
when clip doesn’t have an LRV proxy-copy, or if LRV profile is in the base, but
the physical proxy-copy file is absent.

Delete Proxy… Opens a request window for deleting LRV proxy-copy of a selected clip.
Schedule Duration
Check

Allows forced check of BRV copy duration and updates metadata parameters
according to the actual file. Added in version 2.0.36 Подробнее.

Copy Copying a clip in media database

Paste Pasting a clip in media database When copying materials within one media
database, a line (Copy N) will be added to MediaID.

Delete
Deletes a clip from the media database (metadata, BRV and LRV). Deletion of
BRV from the archive folder is managed by the setting «Enable archive copy
deletion» (see above)..

Delete Hires… Opens a request window for deleting the BRV proxy-copy of a selected clip. This
action is irreversible.

Delete At…

Opens a dialog for setting date and time of clip automatic deletion from media
base

Kill list…

Opens a dialog for batch deletion of files from the media base. All MediaID must
be listed line by line. The list may be uploaded from a file by the button Read
file….

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_36
https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_deleteat.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/maconnect_killlist.png?id=manual%3Aairmanager
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Menu item Description

New→Media
Asset…

Launches a dialog for creating a new asset where you should specify the format
and planned duration. Duration will be adjusted after connecting the video
material and asset.

New→Note…

Launches a dialog for creating a new news note with text input displayed at the
VOD portal.

New→URL…

Launches a dialog for creating a destination link to a network resource. Such
resource, for example, could be an Internet image.

New→Clock…

Launches a dialog of creating a combined clip for displaying TV clock,
containing links to clips with clock background, arrows and audio.

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_newasset.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/vod
https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_newnote.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_newasset.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/maconnect_new_clock.png?id=manual%3Aairmanager
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Menu item Description

New→Local
stream…

Creating a Live clip containing a link to a local source of media data stream.
(e.g. stream name: Capture_1). This technology allows playout of the server
input signal in a playlist. Viewing a live-clip in the File Monitor window will be
available only during local playout at the server.

New→Graphics… Opens graphics editor for creating a new graphic composition.

New→Text…

Launches a dialog for creating a text object containing text information for
titles and referring to design templates (graphic compositions with
parameterization).

Edit… Opens a dialog for editing object settings. For example, it will open the graphics
editor for a graphic object.

https://wiki.skylark.tv/_detail/manual/maconnect_new_localstream.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/graphics_editor
https://wiki.skylark.tv/_detail/manual/maconnect_new_text.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/graphics_editor
https://wiki.skylark.tv/manual/graphics_editor


2025/01/16 20:48 29/56 Air Manager (On-Air Management Client)

wiki.skylark.tv - https://wiki.skylark.tv/

Menu item Description

Apply Design…

Linking a design template to a text object. Text information is unavailable for
editing in this window.

Show info…

Opens the Locations And Triggers tab in the Clip Materials Sheet

window. 

Change fields…

Opens Clip in the Clip Materials Sheet window. Tabs Clip and User
Userallow editing data in user fields of the basic metadata set. The dialog may
be used for batch editing of information in the pre selected group of clips. The
app will save values only for filled out fields, empty values will be ignored while
saving.

https://wiki.skylark.tv/_detail/manual/maconnect_apply_design.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_triggers.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_clip.png?id=manual%3Aairmanager
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Menu item Description

Edit Metadata…

Opens the first available tab with fields of the extended metadata set (fields
are loaded from the connected XMP metadata schema) Clip Materials
Sheet.

https://wiki.skylark.tv/_detail/manual/maconnect_clip_matherial_sheet_xmpmetadata.png?id=manual%3Aairmanager
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Menu item Description

Edit Status…

Opens a dialog for statuses (certificates) editing Clip Materials Sheet.
Names and the number of statuses may be configured in metadata schema
(see above). Status condition flag may have three states:
•
ON (black check mark) - status is set,
•
OFF (no check mark) - status is removed,
•
неопределенное состояние (grey check mark) - appears in case of group
setting of statuses, when status condition of selected clips differs. Statuses with
indefinite condition are ignored, allowing for saving differences while group
editing.

Starting from version 2.4.58 it is possible to set a status color in metadata
schema settings. After setting a status, the clip icon gets a strip of a
corresponding color.

Edit Segments… Opens segment editor.

Archive Launches the archiving process for a clip BRV profile. The archiving process is
managed in the “Archive Queue” window

Restore Launches the process of restoration for a BRV profile. The restoring process is
managed in the “Archive Queue” window

Flush HiRes Launches deleting a BRV profile from the folder with HiRes originals
Archive and Flush The group task combines archiving and further deletion of BRV
Cancel Archiving
Operation Cancels the archiving operation

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_status.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_58
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Menu item Description

Find Segments…

The dialog displays all clip segments marked with key frames of Segment Start
and Segment End types.

Reset triggers… Resets the status of processing of one or several triggers for a selected group
of clips.

Web
Profiles→Create
Profiles…

Creating the needed Web Profiles for a selected group of clips. The Recreate if
exists option forces reencoding the selected profile if it’s already been created
before.

Web
Profiles→Delete
Profiles…

Deleting the needed Web Profiles for a selected group of clips

https://wiki.skylark.tv/_detail/manual/mam_maconnect_clip_menu_findseg.png?id=manual%3Aairmanager
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2025/01/16 20:48 33/56 Air Manager (On-Air Management Client)

wiki.skylark.tv - https://wiki.skylark.tv/

Deleting the needed Web Profiles for a selected group of clips

Media Browser extensively uses possibilities of clip dragging:

Destination Condition Result

To the Windows folder Left-click
Copying a clip BRV copy to the folder. The function
is available if you configure “Client Path” in the
“Storage Parameters” tab and run the app as the
current Windows user

To the Windows folder Right-click
Copying a clip LRV copy to the folder. The function
is available, if you configure “Client Path” in the tab
“Volumes”, and run the app as the current
Windows user.

Into the media database
folder different from the
current one.

Any mouse button Moving clip to a specified media database folder

Into the media database
folder different from the
current one.

Any mouse
button+Ctrl

СCreating a clip copy (Shot Clip) in the destination
folder.

To the current media
database folder Any mouse button

Starting from version 2.4.x this function is no
longer supported. In previous versions: creating a
clip copy (Shot Clip) in the current media database
folder.

Into the media database
folder different from the
current one.

Any mouse
button+Alt

Creating Shortcut This operation requires basic
MAM licensing.

File Monitor Window

The File Monitor window is functioning independently from recording and playback channels of SL
NEO media servers. File Monitor serves for viewing clips selected in the Media Browser window or
from playlist and rec-list lines directly on a screen of a client PC monitor, via the Air Manager user
interface. Other than that, the File Monitor window implements marking of a selected clip: re-
designation of IN and OUT points, cutting playlist lines, export of marked fragments to separate media
files. Operating in File Monitor is independent from work of recording and playback channels of SL
NEO servers and does not affect their performance.
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Element Description
1 Name of clip opened in the File Monitor viewing window

2

The Use Proxy check box includes an opportunity of viewing proxy copies of materials in
the File Monitor window (duplicates the Use Lowres Proxy setting in software configuration)
- a proxy-copy will be displayed if it exists. Using low-res copies for viewing does not
overload server arrays and allows many client PCs connected to SL NEO servers to work
simultaneously in Ethernet network. If viewing proxy copies is activated, but a proxy copy
is absent, the app will display a high res copy. If viewing proxy copies is turned off, but a
high res copy is absent, the app will display a message 'VIDEO OFFLINE'

3
The current cursor position from the IN mark. Click on this field to edit the value. Field
format: HH:MM:SS:FF (or HH:MM:SS;FF for NTSC format), where: HH - hours, MM -
minutes, SS - seconds, FF - frames

4 Shows a list of key frames, allowing for a swift transition to the needed key frame. More
details...

https://wiki.skylark.tv/_detail/manual/airmgr_filemonitor.png?id=manual%3Aairmanager
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Element Description

5

Opens a dialogue for adding a new key frame

6
The current cursor position from the material start. Click on this field to edit the value. Field
format: HH:MM:SS:FF (or HH:MM:SS;FF for NTSC format), where: HH - hours, MM -
minutes, SS - seconds, FF - frames.

7
The video viewing window. Displaying the message 'VIDEO OFFLINE’ means the material is
unavailable. The Client Path option may be configured, but the path is unavailable from this
workplace.

8 Timeline
9 IN point marker
10 Key frame mark

11

While viewing clips, the File Monitor window displays the cursor of a current position
colored gray (pressing R moves cursor to the current record position, pressing Y moves it to
the current playback position). When using File Monitor to view a clip from an executed
playlist, the clip will have a green cursor showing the current playback point.

12 Frame-by-frame reverse playback button.
13 Frame-by-frame playback button.
14 The Stop button - playback stop
15 The Play Button - playback launch
16 КThe button launches cyclic playback of a fragment set by IN-OUT points.
17 The button launches playback of a fragment set by IN-OUT points.
18 OUT point marker
19 Smooth scrolling bar

20

Audio level indicator (DBFS scale). Every bar has a switch at the bottom that implements
channel output to an audio playback device at the client PC:
•
L - output of the selected audio channel to the left channel
•
R - output of the selected audio channel to the right channel
•
A - output of the selected audio channel to both channels
•
Х - output of the selected audio channel is inactive

https://wiki.skylark.tv/_detail/manual/airmgr_filemonitor_orig_keyframeslist.png?id=manual%3Aairmanager
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Element Description
21 Volume control for viewing at the playback device (e.g., a client PC sound card).
22 The button for turning off sound output.

23 IN mark value. Click on this field to edit the value. Field format: HH:MM:SS:FF (or
HH:MM:SS;FF for NTSC format), where: HH - hours, MM - minutes, SS - seconds, FF - frames

24 OUT mark value. Click on this field to edit the value. Field format: HH:MM:SS:FF (or
HH:MM:SS;FF for NTSC format), where: HH - hours, MM - minutes, SS - seconds, FF - frames

25 Button for zooming out timeline
26 Timeline zooming controller
27 Button for zooming in timeline
28 Go to IN point
29 Go to OUT point
30 Button for setting the IN point in the current cursor position
31 Button for setting the OUT point in the current cursor position
32 Button of applying changes of IN and OUT point positions

33
Trimming clip at the cursor When pressed, the OUT point is set at the current cursor
position in the initial CLIP_NAME clip. Also, the app will create a new «CLIP_NAME - Shot 1»
clip with an IN point at the cursor position.

34 Button for creating a shot-clip. Creates a copy of the original CLIP_NAME clip with set IN and
OUT values. The new clip name is «CLIP_NAME - Shot 1».

35 Opens a window for export of a clip fragment (from IN to OUT point).

36
Clip duration value. Click on this field to edit the value. Field format: HH:MM:SS:FF (or
HH:MM:SS;FF for NTSC format), where: HH - hours, MM - minutes, SS - seconds, FF -
frames.

Key Frames and Segment Editor Windows

Working with key frames and segments

Playlist Columns
Column Name Description

Group Specifying a name for a group of clips. Groups may be used, for instance,
to create a block of commercials.

Status
Статус события. С версии 2.2.10 Done/Skipped lines display the
difference between actual duration of events and the values set in a
playlist. Example: D -00:00:01:12 - the event with a “Done” status is
one second and twelve frames shorter than the planned one.

Start

The launch type for playlist elements. The following launch types are
currently supported:
•
Manual - launch is implemented manually or via GPI.
•
HardTime - launch is implemented automatically at a certain moment,
manual launch is possible.
•
Auto - launch is implemented automatically at the end of the previous
element, manual launch is possible.

https://wiki.skylark.tv/manual/mediaconnect#bm_keyframes
https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_10


2025/01/16 20:48 37/56 Air Manager (On-Air Management Client)

wiki.skylark.tv - https://wiki.skylark.tv/

Column Name Description

Start Time
The time of start value is calculated automatically for events with Auto
type and may be set manually for events with Manual type. For events
with Hard Start type, the option sets the time of on-air broadcasting.

Media Clip MediaID, its unique identifier in a media base
Event Dur Event duration (clip duration considering the Loops value)

Player Defines the playout source in the main playlist (server or matrix input)
and the graphics playout layer for secondary events

Type
The string type custom field for extra automation. For example, you can
use it to set an event type (commercial/movie/program) according to
which the app will change graphic design of a TV-channel

Title The displayed event title: when dragging clip from the media base,
duplicates the field Media.

Comment Event comment
Date Event playback date.

In Point IN point Sets the time code for the start of a played back fragment of the
clip. Allows trimming clip in a playlist by setting its start point

Out Point OUT point Sets the time code for the end of a played back fragment of the
clip. Allows trimming clip in a playlist by setting its final point.

Stop Time The planned time of the event end.

Tape The Tape field from a media base, it used to contain the name of tape
from which the clip was digitized

Loops Sets the number of loops, which may be an integer or “inf” for infinite
events.

Clip Dur Clip duration from IN to OUT point, not considering loops (Loops column).
Cur Point The current played back clip position.

Mixer

Type of transition to the next line:
•
Cut - Direct splice transition
•
V Mix - Smooth transition with fade out.
•
X Mix - Dissolve transition.
•
Overlay - Transition via the animated clip with transparency (DVE).

MixSpeed Duration of a transition set in Mixer column, specified in frames or
selected from the list: Slow = 1 sec, Mid = 0.5 sec, Fast = 0.25 sec

MixWipe
For Overlay type of transition, the option sets a graphic clip used for
transition. For V-Mix and X-Mix types, the option sets a wipe-map used for
transition.

Keyer1,
Keyer2,Keyer3,Keyer4

Columns for custom automation - for instance, launch of actions
depending on the set value. Possible values: On, Off, No Change (default).
The function could be used for showing/hiding logo or graphic layers.

Key1Speed, Key2Speed,
Key3Speed, Key4Speed

Columns for custom automation - for example, setting speed of
showing/hiding graphic layers.

GPI 1, GPI 2, GPI 3, GPI 4,
GPI 5, GPI 6, GPI 7, GPI 8

Custom automation - for instance, launch of actions depending on a set
value. Possible values: On, Off, No Change (default)

GPI V 1, GPI V 2, GPI V 3,
GPI V 4, GPI V 5, GPI V 6,
GPI V 7, GPI V 8

Custom automation - for instance, launch of actions depending on a set
value. May contain random text value. Air Manager The columns
automatically receive content from standard metadata fields (see
Comparison of Transferred Data).

https://wiki.skylark.tv/manual/graphics_editor_wipes
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Column Name Description

Orig TC
The option sets positioning IN and OUT points relatively to a selected clip
segment (requires preliminary marking of clips via key points Keyframe
Segment Start and Keyframe Segment End).

LeadOut
The field sets the value (in frames) of extra playback time of a line after
its end. The value serves for setting playback time of a graphic hiding
animation (lower third collapsing and disappearing after pressing Stop).

Opaque

The column allows switching the layer transparency mode. By default,
graphic layers are transparent - if a frame has alpha channel, video is
mixing with previous layers (see information on audio mixing in the Aud
Transp column description).
•
On - opaqueness is on,
•
Off - layer is transparent,
•
No Change - layer is transparent (default).

ID Program ID from the media planning system. The playlist receives it in the
process of being formed by a traffic system (e.g. BroadView).

Aud Transp

Managing audio mixing between this layer event and the result of audio
overlaying in all previous layers (layers overlay one by one, starting from
the first one). If the value is Auto, mixing is implemented with no changes.
If you set a numeric value, it will define the volume level for the result of
overlaying previous layers, when mixing it with the current layer (e.g., a
10% value sets the 10% of max volume level for previous layers).

HS State The status of Hard Start execution. Active - HardStart will be executed.
InPast - time in the past set for HardStart (the event will not be executed).

MT State

The Media Transfer State column shows the status of processing the asset
in Transfer Manager. This function requires the playlist service to be
specified in the Playlists tab of Transfer Manager. Example of possible
messages:
•
Queued - queued for processing
•
Copying NN% - copying in process
•
Outdated - file already exists

Purge Sets the date of clip deletion from the media base after the line playback

End Mode

Event end type:
•
Normal - normal event end, transition to processing the next event.
•
Hold - after the end, the event switches to the Hold status, waiting for a
finishing command from the operator. This scheme is normally used when
planning “live” events.
•
Group - at the end of the element, Air Manager implements automatic
jump to the first playlist element with the same Group column value. It
allows looping a group of playlist elements. Added in 2.2.46 version

Sched Time Displays the original planned time of start set in a playlist. Added in
2.2.10 version.

OverRun
Displays the difference between the original time of start set in a playlist
and actual (planned) time of start that comes from the process of playlist
executing. Added in 2.2.10 version

https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_10
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Playlist and Rec-list Format

Air Manager Playlist Structure
Air Manager Rec-list Structure

Playlist Zonation Function

Playlist zones delimit areas of responsibility of programme and on-air services.

The option is activated in program channel settings: Administrator Control
Panel→Manage→Program Outputs→Program_N→Automation→Parameters→Auto zones for
layers.

Parameter Value
None Playlist zonation is turned off
Main The function is activated for the main playlist
Main & 1st Graphics The function is activated for the main playlist and first graphic playlist

The scheme showing zone positioning on the timeline

Displaying zones in the Air Manager playlist.

Playlist area with already played back materials1.

https://wiki.skylark.tv/api/playlist_structure
https://wiki.skylark.tv/api/record_list_structure
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The played back clip2.
«Execution zone» area3.
«Operator zone» area4.
«Traffic zone» area5.

Execution zone

5. «Traffic zone» area

The size of this area is specified in program channel settings: Administrator Control
Panel→Manage→Program Outputs→Program_N→Automation→Parameters→Execution zone (в
формате часы, минуты, секунды).

Operator Zone (On-air Service Area of Responsibility)

The playlist area that can be modified by the on-air operator. Changing playlist in this area from the
media planning system is not available. By default this area contains none elements (is equal zero)

Changing zone positioning on the timeline over time (comparing to the scheme A), if the on-air
operator has not expanded the “Operator zone” area.

https://wiki.skylark.tv/_detail/manual/airmgr_zones_execution_zone_error.png?id=manual%3Aairmanager
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Example of displaying a playlist with absent “Operator zone”.

The operator may request extending the “Operator zone” by reducing the “Traffic zone” area. The
media planning system no longer controls the area passed to “Operator zone” management.
«Operator zone» extending is implemented in two steps:

In the “Traffic zone” area, select a playlist element to which the “Operator zone” area will be
expanded.
Right click and choose «Expand Operator Zone».

Traffic zone (Program Service Area of Responsibility

The area, where data is edited by the system of media planning. Any attempts to change the playlist
in this area will give the message: «Traffic zone can't be modified».

While using this function, the Message List window may display informational messages connected
with its work.

Message Value

“1.clf”: playlist successfully loaded Playlist has been successfully loaded or updated in case
of modifying.

“1.clf”: schedule tail successfully updated Changes at the end of playlist has been successfully
loaded

“1.clf”: schedule items changed while block
is being executed

Changes at the end of playlist has been successfully
loaded.

https://wiki.skylark.tv/_detail/manual/airmgr_zones_playlist2.png?id=manual%3Aairmanager
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Message Value

“1.clf”: schedule start time changed while
block is being executed

An attempt to change Playlist upload time when the
playlist is already being executed. Playlist is not
updated.

Function of Checking MAM Certificates

Configuring

At the first Air Manager launch it is necessary to implement several settings: AirManager→Меню
File→Configure→Вкладка Storage

The basic settings are listed in the description of Media Connect:

Connect to the media base and choose a metadata schema
Specify metadata schema fields that will be displayed in Media Browser
Set the profile of material displayed in the File Monitor window

Set limitations of statuses for playlist clips

Air Manager allows permanent monitoring statuses of clips against the set criteria.
File→Configure…→Вкладка Actions→Media Certificates…

Group Description

Required Certs Required Certificates Certificates are marked with checkboxes. Playlist materials
must have all statuses checked in this field.

Incompatible Certs Incompatible Certificates

If the material does not correspond the Media Certificates configuration criteria, the Status playlist
column will show the message “CertMismatch” and the line will beсome red.

Important! The material anyhow will go on-air, status check has informational character.

https://wiki.skylark.tv/manual/mediaconnect
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Color setting options for Player

Starting from version 2.0.154 there is an option to set colors to playlist lines depending on values in
the Player column.

Configuring the option in Air Manager: Меню File→Configure→Actions→Player colors

Option Description
Name Player name
Color The set line color selected from the color palette
Add Opens a dialogue for adding a new value
Remove Removes the selected value

Edit

Opens a dialog for editing the selected value

Result of the function work:

The option will be useful for on-air operators able to value the convenience of highlighting external
lines in playlists.

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_154
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Marker Displays Function

In the verision 2.0.58 the function Marker Counters has been added: displaying counters with real-
time information about playout. The 2.3 line allows viewing video streams from virtual services, so the
function has been renamed to Marker Displays.

The function allows displaying:

“On-air” indicator
Current position in a clip
Server time
The time left till the key frame
etc.

Configuring the function: Меню Window→Marker Displays→Add Counter…

Option Description
Title Random counter name Starting from version 2.4.26 TitleBar is displayed with center alignment

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_58
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Option Description

Type

Counter type:
•
IPOut Status - Server IP output status monitoring Added in 2.4.73 version.

  
•
Countdown to Selected - countdown of time left till the selected playlist line goes on-air.

•
Reclist Selected Duration - shows duration of selected events in a rec-list.
•
Playlist Selected Duration - shows duration of selected events in a playlist.

•
Countdown to Condition - countdown of time till the playlist line with set values in certain columns. Added in 2.4.23.
•
Current Rec Remaining - time left till the end of the current record task (executable rec-list line). Added in 2.4.23.
•
Current Rec TC - shows the current recorder time code. Added in 2.4.23.
•
Current Rec Position - shows duration of the recorded material. Added in 2.4.23.
•
Record/Play Delay - displays latency between the recorded and played back points of the video. The value is calculated as of the record time code, so for proper functioning you must choose the
time code source “Time” for the recorder. Added in 2.4.23.
•
Have NoMedia Items - the marker displays presence of “NoMedia” elements in a playlist and implements countdown till the playlist line with “NoMedia” element

 
•
Current Graphics - shows the current played back clip name in the main playlist, graphic layer or logo layer. The layer is set by Layer parameter, for example: Layer=1 - main playlist. Background
color shows the current state of connection to the layer: green means the counter is connected to the playlist and the playlist service is active, red - no connection to the playlist service. Added in
2.2.11

 
•
Current Clip Remaining - time left till the end of a current clip in format: HH:MM:SS. Added in 2.1.22

•
Countdown to Line - time left till a playlist line goes on-air. The line is selected by dragging it to the counter. This allows, for instance, to control the time left till the start of a live broadcast. Added in
2.0.154.

•
Recording Indicator - - recorder indicator. Displays the current recorder status. Red - recording is on, grey - recording is stopped. Added in 2.0.154.

 
•
Playlist Remaining - time left till the end of playlist

•
On Air Indicator - on-air indicator. Displays the current status of a program channel. Red means live broadcast, grey - the playlist is stopped.

 
•
Current Clip Position - the current position of playback in a clip.

•
Wall-Clock Time - the server time.

•
Countdown to Marker - the time left until the next key frame.

•
Service Monitor - opens the window for viewing a video stream with audio from SL NEO services (Capture, Program Channel, Recorder etc.). Above the viewing window, there is a selection dialog box
with the list of services available by the specified IP address. Added in 2.3

https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_73
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_ipoutstatus_1.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_ipoutstatus_2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_ipoutstatus_3.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_countdowntosel.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_playlistseldur.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_23
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_23
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_23
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_23
https://wiki.skylark.tv/changelog/slneo_2.4#s_2_4_23
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_nomedia_ok.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_nomedia_countdown.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.2#s_2_2_11
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_curgraph.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_curgraph_red.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.1#s_2_1_22
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_playlistrem2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_154
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_counttoline.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_154
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_recording.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_recording2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_playlistrem2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_onair.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_onair2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_clip_pos.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_clock.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_coundown.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.3
https://wiki.skylark.tv/_detail/manual/airmgr_marker_counters_monitor.png?id=manual%3Aairmanager


Last update: 2023/05/08 15:59 manual:airmanager https://wiki.skylark.tv/manual/airmanager

https://wiki.skylark.tv/ Printed on 2025/01/16 20:48

Option Description
Accessibility of options depends on the counter type

Output IP IP address of the server forming the main IP stream
Output Service Name of the Playout service forming the main IP stream. Example: Playout_1.
Backup IP IP address of the server forming the backup IP stream
Backup Service Name of the Playout service forming the backup IP stream. Example: Playout_2.
Recorder IP Name of the Playout service forming the backup IP stream. Example: Playout_2
Recorder Num Recorder service number
Program IP IP address of the server with a program channel - localhost or 127.0.0.1, if Air Manager is launched at the server
Program Num The number of the program channel service
Layer The layer number in a selected program channel. 1 - main playlist, 2 - first graphic playlist (CAST_LAY2) etc.
Marker offset The option sets marker offset when calculating the Countdown to Marker value. 1- next one, 2- every other, etc

Condition

The condition for seraching a line in playlist for the Countdown to Condition counter. Setting is similar to the action editor and Secondary Event Generations.

Seconds only

Turns off displaying frames or milliseconds in a counter.

Bold font

Sets “bold” font for displayed text

 → 

FG Color

Sets the font color for displayed text Added in 2.4.23.

BG Color Sets the background color. Added in 2.4.23.

Created counters are displayed in the Air Manager toolbar. The counters may be dragged and resized.

Right-click the counter to open a menu:

Parameter Value
Configure… Opens the counter setting window
Destroy counter Deletes the counter

Close Hides the counter To open the counter again, right click on a toolbar divider or use
the menu Window→Marker Displays→Add Counter….
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“Toggle Scrubbing Controls” Function

In the version 2.0.57 we have added a new possibility for interactive production that allows users to
quickly set a point for playback start of a playlist clip.

Right click the progress-bar line in the lower section of a playlist window displays the «Toggle
Scrubbing Controls» menu, opening access to controls.

Description of used controls:

Cursor - displays the current playback position. It is positioned at the end of the progress bar.1.
Dragging the cursor changes the CurPoint value (clip playback will start from this point).
Jog-line - dragging the line allows changing the CurPoint value more precisely.2.
CurPoint - the value of a current playback point.3.
EventDur - the value of time left till the end of the current playlist element.4.
General Duration of playback of the current playlist element including loops.5.
Cue Button - prepares a clip to start.6.
Freeze Button - works as a pause. Stops the clip playback. Repeated pressing resumes playou.7.

Dragging the cursor and Jog-line is possible, when a clip has the status Cued, Playing or Paused.

Function of Backup Recording

Before the version 2.0.71 the Backup column was used for backup recording of rec-list events,
activating this function for a certain rec-list line

Starting from version 2.0.71 work of this function has been significantly modified.

https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_57
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Configuring Backup

Configuring this option is implemented in the server control panel: Administrator Control
Panel→Manage→Recorders→Recorder_N→General.

Option Description
Backup recorder address IP address of the server with launched backup recording service

Backup recorder channel The sequence number of a server recording service displayed in the title of
a corresponding recording service

Modifying this section reloads the recording service and
stops the current tasks.
At the end of configuring, save the changes by clicking
“Apply Changes”.

Backup Launch

https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup_config.png?id=manual%3Aairmanager
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Backup function management is implemented through a menu in the lower left corner of the rec-list
window. The Rec-list backup column is left for backward compatibility and is not in use anymore.

Option Value

Connect Backup The option includes backup recording and activates the connection to a slave
recording service

Disconnect Backup The option turns off backup recording and disconnects from the slave recording
service

Synchronization of slave rec-list events is implemented in the moment of changing the master
recorder of a rec-list. If you manually add a task to the slave recorder playlist with activated function
of synchronization, this task will automatically get the Skipped status

Indication of Recorders Synchronization Condition

Indication Status Description
FRN (Backup Not Connected) - connection to the backup recording service is not
implemented
N/A (Not available) - recorder status is unknown. Such indicator condition means the
current recorder doesn't have a set Backup Recorder. Perhaps, this recorder is slave
(backup) itself.
SYN (Backup Connected) - backup recording is implemented for this recorder. Backup
recording service is connected
SYN (Master Present) - the recorder implements backup for a master recording service.
The main recorder has been connected. The service with such status is slave, receiving
data from the main recorder

Function of Metadata Automatic Transfer to Playlist

Starting from version 2.0.77, we have provided an option for automatic data transfer from user fields
of the basic metadata set to executable playlist columns. The function works both for automated load

https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup_frn.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup_na.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup_syn_green.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/airmgr_recorder_backup_syn_yell.png?id=manual%3Aairmanager
https://wiki.skylark.tv/changelog/slneo_2.0#s_2_0_77


Last update: 2023/05/08 15:59 manual:airmanager https://wiki.skylark.tv/manual/airmanager

https://wiki.skylark.tv/ Printed on 2025/01/16 20:48

of playlist from a media planning system and for manual adding elements to the playlist

Configuring

The function “Active Folders” is activated in program channel settings: Administrator Control
Panel→Manage→Program Outputs→Program_N→Storages→Edit→Active folders…, where N is
the number of program channel.

Specify a folder (Active folder) and choose metadata fields for transfer in settings of a media base
connected to the program channel.

Selected metadata is automatically transferred to playlists only for those clips or (или Shortcut), that
are located in a corresponding folder of the media base. Clips identification is implemented by the
MediaID field value.

Folder
The parameter contains the name of analyzed folder in the media base root (e.g.
promo). The system automatically analyzes clips in all embedded folders. To analyze
a certain embedded folder, specify its path (e.g.: promo/adv/2015).

List of
metadata fields Choosing values for transfer to the playlist. See the table below.

https://wiki.skylark.tv/_detail/manual/neovid_program_channel_config_storage_edit.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/program_channel_configuration#storages
https://wiki.skylark.tv/manual/program_channel_configuration#storages
https://wiki.skylark.tv/manual/mam#bm_shortcut
https://wiki.skylark.tv/_detail/manual/neovid_program_channel_config_storage_add_folder.png?id=manual%3Aairmanager
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Comparison of Transferred Data

№ Option in “Active folders”
settings

Value in the Media
Browser window Executable playlist column

1 Title Field Clip Name Title

2 Adjust Durations Duration
Clip Dur, Event Dur (Automatic setting of
duration. The value Loops is set as equal
1, In=00:00:00:00, Out=Dur)

3 Comment Field Comment Comment
4 Player Field Player Player
5 Type Field Type Type
6 User Field 1 User 1 GPI V 1
7 User Field 2 User 2 GPI V 2
8 User Field 3 User 3 GPI V 3
9 User Field 4 User 4 GPI V 4
10 User Field 5 User 5 GPI V 5
11 User Field 6 User 6 GPI V 6
12 User Field 7 User 7 GPI V 7
13 User Field 8 User 8 GPI V 8

Changing user metadata fields of a clip in media base will update the transferred values for all playlist
parts in real-time.

Work Features

Changing the Duration value of an executable clip in media base will stop playlist playback, if the new
Duration value is lower than the current playback position.

If Shortcut of a playlist clip with already transferred metadata has been deleted from the analyzed
folder, repeated adding a clip with the same MediaID to the playlist will still copy metadata for the
current clip. The data will be copied from the playlist clip fields.

Editing Metadata

Selective editing of user fields in the basic metadata set is implemented in Media Browser by clicking
on the needed field in «View as short list» or «View as long list» displaying modes.

Group editing is implemented using the “Change fields…” editing window.

https://wiki.skylark.tv/_detail/manual/airmgr_playlist_metadata_autoload.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/mam#bm_shortcut
https://wiki.skylark.tv/manual/mediaconnect#bm_mediabrowser_changefields
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Work with ANC Data (SCTE-104 Messages, Teletext)

Information on ANC data presence for a selected clip is available in the dialog: Air Manager→Media
Browser→Меню правой кнопки→Show info…→HiRes→ANC Data или Air Manager→окно Clip
Materisls Sheet→HiRes→ANC Data.

Possible values:

NONE - no data,
VANC DBG - the file was recorded with the activatedDebug VBI function
TTX-B-625 - teletext data is present,
SCTE-104 - SCTE messages,
CC CEA-608/CEA-708 - closed captions,
AFD - AFD code
etc

Marking Frames in Monitor Window

The option Show ANCs: Air Manager→Меню File→Configure→Preview→Show ANCs activates
displaying ANC data while viewing in the Monitor window.

https://wiki.skylark.tv/_detail/manual/airmgr_captions_showinfo_2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/transmitting_data_in_tv_signal
https://wiki.skylark.tv/manual/afd
https://wiki.skylark.tv/_detail/manual/scte104_find_frame_4.png?id=manual%3Aairmanager
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Data presence is defined individually for every frame selected at a point of time, displaying the
corresponding message over the image.

Possible values:

TTX-B-625 - presence of teletext data,
SCTE-104 - SCTE messages,
CEA-608/CEA-708 - closed captions,
AFD: X - presence of the AFD code with the number X.

Search of Marks in Monitor Window

Starting from version 2.1.22 the app has the Find next SCTE-104 frame, function available by the
right click on a file name in the Monitor window. The function launches search of SCTE-104 packets,
starting from the current position in a clip.

https://wiki.skylark.tv/_detail/manual/scte104_find_frame_3.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/scte104_find_frame_5.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/subtitles
https://wiki.skylark.tv/manual/subtitles
https://wiki.skylark.tv/manual/afd
https://wiki.skylark.tv/changelog/slneo_2.1#s_2_1_22
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If the SCTE-104 packet is found, its content will be displayed in a pop-up window

Recording clip in the Debug VBI mode makes search of
marks unavailable.

Graphics Editor

Graphics Editor

Hotkeys Combinations

The information is actual starting from version с 2.3.87.

Combination Action
Ctrl+F Show File Monitor
Ctrl+T VTR Control window activation
P, when the monitor is active Apply
A, when the monitor is active Add
C, when the monitor is active Cut

https://wiki.skylark.tv/_detail/manual/scte104_find_frame_1.png?id=manual%3Aairmanager
https://wiki.skylark.tv/_detail/manual/scte104_find_frame_2.png?id=manual%3Aairmanager
https://wiki.skylark.tv/manual/graphics_editor


2025/01/16 20:48 55/56 Air Manager (On-Air Management Client)

wiki.skylark.tv - https://wiki.skylark.tv/

Combination Action
+ Zoom In
- Zoom Out
<I> set In
<O> set Out
<D> clear In
<F> clear Out
<G> clear In and Out
<Q> goto In
<W> goto Out

R, when the monitor is active While viewing the clip being recorded in the File Monitor window, it
moves the viewing cursor to the current recording position

Y, when the monitor is active While viewing the clip being played back in the File Monitor window,
moves the viewing cursor to the current playback position

<Enter> play selection
<Up> goto begining of the clip
<Down> goto the end of the clip
<Space> toggle play/stop
<Ctrl>+<Up> goto prev marker
<Ctrl>+<Down> goto next marker
Ctrl + N Insert clip to the N playlist
Alt + N Добавить клип в конец плейлиста N
Для кнопок верхнего меню
Ctrl+Shift + 1-4 REC window activation
Shift+F1 Pretake
Shift+F2 Rec
Shift+F4 Marker
Shift+F5 Skip
Shift+F6 Stop
Shift+F7 Restart
Ctrl+Alt + 1-4 Playout window activation
Shift+F1 Pretake
Shift+F2 Play
Shift+F3 Jump
Shift+F4 Pause
Shift+F5 Skip
Shift+F6 Stop
Shift+F7 Restart
Shift+F8 Toggle Preempt
Shift+F9 Hold
Shift+F10 Alarm Clip
Ctrl+L Auto Scroll
Ctrl+Shift+Space Clear the group
Ctrl+Space Edit parameters
Ctrl+H Set the HardStart type of start
Ctrl+U Set the Auto type of start
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Combination Action
In Media Browser
Ctrl + N Insert clip to the N playlist, where N is the playlist number
Alt + N Insert clip to the end of N playlist, where N is the playlist number
<Left> -1 frame
Shift+<Left> -5 frames
Ctrl+<Left> -10 frames
Ctrl+Alt+<Left> -1 sec
<PgUp> -3 sec
Shift+<PgUp> -10 sec
Ctrl+<PgUp> -30 sec
Ctrl+Alt+<PgUp> -1 min
<Right> +1 frame
Shift+<Right> +5 frames
Ctrl+<Right> +10 frames
Ctrl+Alt+<Right> +1 sec
<PgDn> +3 sec
Shift+<PgDn> +10 sec
Ctrl+<PgDn> +30 sec
Ctrl+Alt+<PgDn> +1 min
Ctrl+<,> Left faster
Ctrl+<.> Right faster
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